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POP3 Scan Mailbox - Version 1.0

If you’re like me, you won’t want to waste time reading a boring User Guide before trying out the program. 
Scan Mailbox has been designed to be fairly intuitive in use but there is some important information in this 
Guide which you need to know. Please at least scan through the User Guide before running the program for 
the first time.

This document is provided in both Word and PDF formats. Although the Word User Guide can be displayed 
using WordPad, it will not be formatted correctly. If you don’t have Word on your system, you can download
a free Word viewer from:

http://www.microsoft.com/word/Internet/Viewer/default.htm

If you prefer the PDF format, you can download a free PDF reader from:

http://www.adobe.com/

This User Guide may be printed on A4 paper directly and on US Letter size paper by removing the headers 
and footers.
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1. Introduction
POP3 Scan Mailbox is available in both 16-bit and 32-bit versions, designed for use under Windows 
3.x, Windows 95 and Windows NT. The program has been tested with the Winsock supplied as part of
Windows 95 and NT and with the Trumpet winsock. It is compatible with dial-up, ISDN, leased line 
and LAN connections. Scan Mailbox has been tested with several POP3 servers and is compatible with
any POP3 server which implements RFC 1939 (the current standard definition).

Scan Mailbox is not intended to be a full email program but is designed to complement your usual 
mail program by providing features which are not generally present in the leading Windows mail 
programs such as Pegasus, Eudora, Agent and Turnpike.

Scan Mailbox enables you to connect to a POP3 mail server, display a list of incoming email awaiting 
delivery, display the contents of selected mail messages and selectively save or delete any messages, 
including unwanted or junk mail. Multiple accounts are supported, connections can be automated and 
unwanted mail can be deleted automatically based on user-specified criteria.

2. Installation
POP3 Scan Mailbox is provided in four versions, two for Windows 3.x and two for Windows 95 and 
NT:

1. As a full version for Windows 95 and NT with an InstallShield installation program.

Download smb3201.zip into a temporary directory, unzip it and run the setup program.

2. As an upgrade for those who have version 0.75 or later of the Windows 95/NT version already 
installed on their system.

This file is named smb3201u.zip and is identical to smb3201.zip except that the unchanged 
DLL and OCX files are omitted.

3. As a full version for Windows 3.x, requiring a manual installation process.

Download smb1601.zip into a temporary directory and follow the installation instructions 
below.

4. As an upgrade for those who have version 0.75 or later of the Windows 3.x version already 
installed on their system.

This file is named smb1601u.zip and is identical to smb1601.zip except that the unchanged 
DLL and OCX files are omitted.

To install Scan Mailbox, unzip the distribution file into a temporary directory and follow the 
instructions below.
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Installing Scan Mailbox for Windows 95 and NT

For the first time

Close down all Windows programs.

Using Windows Explorer, navigate to the temporary directory where the distribution file smb3201.zip 
was unzipped, double click on the ‘setup.exe’ file and follow the instructions displayed on the screen.

If you don’t already have the Microsoft vb40032.dll file in your c:\windows\system directory, 
download this file separately as vb40032.zip from one of the following Web sites:

http://www.kempston.demon.co.uk/smb/
http://www.netcomuk.co.uk/~kempston/smb/ 

Unzip it and copy vb40032.dll into c:\windows\system.

Save the smb3201.zip distribution file elsewhere in case you ever need to re-install Scan Mailbox and 
delete the contents of the temporary directory.

Upgrading from a previous version

These instructions apply only if upgrading from Scan Mailbox version 0.75 or later. Please follow the 
instructions entitled “Installing Scan Mailbox for the first time” if upgrading from an earlier version of
Scan Mailbox.

Copy the following files from the temporary directory into your existing scanmail directory, 
overwriting all files if prompted:

manual.doc manual.pdf
readme.txt scanmail.exe
scanmail.hlp scanmail.cnt
changes.txt

Save the smb3201u.zip distribution file elsewhere in case you ever need to re-install Scan Mailbox and
delete the contents of the temporary directory.

Start the Scan Mailbox program by using your existing shortcut in the Programs folder or on the 
desktop. Your existing account and configuration options will be recognised by the new program.
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Installing Scan Mailbox for Windows 3.x

For the first time

Close down all Windows programs.

Create a ‘scanmail’ directory at a suitable point in your file system, for example as ‘c:\scanmail’.

Copy the following files from the temporary directory into the new scanmail directory:

manual.doc manual.pdf
readme.txt scanmail.hlp
scanmail.exe scanmail.cnt
changes.txt

The following files are also provided with Scan Mailbox and are listed below with the size in bytes 
and version number:

File Size Version

comdlg16.ocx 81,136 1.0.2908
compobj.dll 109,056 2.03
ctl3dv2.dll 27,632 2.31
dssock.vbx 21,024 1.25.00
grid16.ocx 85,536 1.0.2908
oc25.dll 536,048 2.53
ole2.dll 304,640 2.03
ole2disp.dll 164,960 2.03
ole2nls.dll 152,976 2.03
storage.dll 157,696 2.03
tabctl16.ocx 115,424 1.0.0023
typelib.dll 177,824 2.03
vaen21.olb 35,200 2.0.5422

For each of these files, check whether you already have a file of the same name in the c:\windows\
system directory. If not, copy the file from the temporary directory into c:\windows\system.

For each file which already exists in c:\windows\system, check its version number by using File 
Manager: click on the file and select File then Properties from the menu. If this version number is 
lower than the version number listed above, you should replace the file with the version supplied with 
Scan Mailbox; if your existing file has a higher version number, it must not be replaced with the 
version supplied with Scan Mailbox.

To replace a file which has a lower version number, save the old file if you wish and then copy the file
from the temporary directory into c:\windows\system, overwriting the old version of the file.

Please note that the file supplied with Scan Mailbox should be installed only if its version number is 
higher than the file which already exists on your system.
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If you don’t already have the Microsoft vb40016.dll file in your c:\windows\system directory, 
download this file as vb40016.zip separately from one of the following Web sites:

http://www.kempston.demon.co.uk/smb/

http://www.netcomuk.co.uk/~kempston/smb/

Unzip it and copy vb40016.dll into c:\windows\system.

Create an icon for the new program in a suitable Program Manager group by opening Program 
Manager, selecting “File”, “New” and “Program Item”. Type “Scan Mailbox” into the box marked 
“Description”, the path to the scanmail.exe file (for example, c:\scanmail\scanmail.exe) in the box 
marked “Command Line” and the name of the Scan Mailbox directory (for example, c:\scanmail) in 
the box marked “Working Directory”. Finally, click on “OK”.

Save the smb1601.zip distribution file elsewhere in case you ever need to re-install Scan Mailbox and 
delete the contents of the temporary directory.

It is recommended that you close down and restart Windows at this point if you have copied files into 
c:\windows\system.

Start the Scan Mailbox program by opening the appropriate Program Manager group and double-
clicking on the Scan Mailbox icon.

Upgrading from a previous version

These instructions apply only if upgrading from Scan Mailbox version 0.75 or later. Please follow the 
instructions “Installing Scan Mailbox for the first time” if upgrading from an earlier version of 
Scan Mailbox.

Copy the following files from the temporary directory into your existing scanmail directory, 
overwriting the existing files with the same name:

manual.doc manual.pdf
readme.txt scanmail.exe
scanmail.hlp scanmail.cnt
changes.txt

Save the smb1601u.zip distribution file elsewhere in case you ever need to re-install Scan Mailbox and
delete the contents of the temporary directory.
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3. Account Configuration
When the program is run for the first time and before the first Account has been configured, the 
program displays a “Welcome” screen which invites you to Configure Now or Configure Later.

If Configure Later is chosen, the program may be explored but all actions which are dependent on an 
Account having been configured are disabled.

If Configure Now is chosen, an Account Configuration window is displayed, asking you to specify 
details of at least one account. This dialogue can be displayed later, to add further accounts or to 
delete existing accounts, by selecting Accounts from the Configure menu under the File menu.
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The fields in this dialogue window should be filled in as follows:

New Account Name Choose a name for an account and type it in this box. The Account 
Name may be the name of your ISP, such as Demon, or any name 
you choose. The name may not contain slash or quote characters
 ( / " ' ) but may contain spaces. Account Names are case-sensitive.

After typing an Account Name, click on the Apply button to record
the name.

Selected Account To change the details of an existing account, click the downward 
pointing arrow and select the name of an existing account. The 
details associated with the selected account are displayed and can 
be changed if wished.

To delete an existing account, select the Account Name and click 
on the Delete button.

Details for Account:

POP3 Server Enter in this box the name of the POP3 Server to be associated 
with the selected account. The name of Demon’s POP3 server is 
pop3.demon.co.uk

Login Name Enter the name by which you are identified to the POP3 server. If 
your email address is ‘someperson@someisp.com’, your login name
is probably ‘someperson’ (without the quotes).

For use with Demon Internet, enter either your Demon hostname or 
your mail username followed by a plus symbol and your hostname. 

If your email address is ‘someperson@somehost.demon.co.uk’, 
entering ‘somehost’ in this box will result in the program listing 
mail waiting for all users at your host. Entering 
‘someperson+somehost’ will result in the program listing only mail 
waiting for a particular user at your host.

Password Enter your POP3 Password unless you prefer to enter it each time 
you connect to the POP3 server. The password is displayed on the 
screen as a series of asterisks for security reasons. If a password is 
entered here, it is stored in encrypted form in the “scanmail.ini” 
file.

For use with Demon, enter your standard dial-up password unless 
you have set up a different password for use with Demon’s POP3 
service.

To set up a password for Demon’s POP3 access which is different 
to your standard dial-up password, use a telnet program to connect 
to password.demon.co.uk and follow the instructions displayed. A 
password for Demon’s POP3 service which is different to your 
standard dial-up password must be set up if you wish to use 
Scan Mailbox while connected to the Internet from outside 
Demon’s domain.
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Confirm Password Enter your POP3 Password again if you have entered the password 
in the Password box.

Click on the OK button to complete setting up the new account.
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4. General Notes
The program makes use of a toolbar to enable common functions to be selected by means of a single 
click of the mouse.

Tooltips are provided: hover the mouse over each button to see what it does. For those who prefer a 
minimal interface, the toolbar may be switched off on the Miscellaneous tab in Global Options. All 
toolbar functions are also available from the menus and some functions can be invoked by means of 
keyboard shortcuts or by using the mouse elsewhere in the program’s window.

When the program is run for the first time, it sets the size of its main window so that it displays 
correctly in a standard SVGA screen with 640 x 480 resolution. Users with screens set to a higher 
resolution may prefer to enlarge the window so that the fields in the mail list are wider and so that 
details of more messages can be displayed without having to scroll the list. Similarly, the window can 
be reduced in size but an attempt to make it smaller than its minimum size will result in the window 
snapping back to its minimum size.

To resize the main window and make it larger or smaller, position the mouse on a window edge or 
corner, then click and drag the window to the desired size. Scan Mailbox remembers the revised size 
whenever the program is run.

The widths of the fields in the mail list may also be adjusted by positioning the mouse on a field 
boundary on the first (header) line of the mail list and dragging the boundary to the left or to the right. 
Changes to the sizes of these fields are remembered by the program and field sizes may be set 
differently for each Account tab. Note that the program resizes fields in the mail list if the main 
window is resized unless ‘Resize mail list columns automatically’ is switched off on the 
Miscellaneous tab in Global Options.
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5. Connecting and Listing Mail
When Scan Mailbox starts, it displays a tab for each account which has been defined and each tab is 
associated with a list of mail. A coloured marker on each tab denotes its status: a yellow marker 
indicates that the corresponding account has not been connected to a POP3 server in the current run of 
the program; red indicates that the tab is currently connected; and green indicates that the tab has been
connected during this session but is now disconnected. The green marker is displayed with a red centre
if there are messages listed on a tab which is now disconnected.

To select an account, prior to connecting to the POP3 Server and displaying details of incoming mail, 
click on the required tab or choose it from the Account menu. When the tabs have focus, the cursor 
arrow keys can be used to switch between accounts.

Scan Mailbox remembers the currently selected account between runs of the program.

Ensure that your computer is online to your Internet Service Provider (ISP) and connect to the POP3 
server. There are several ways of doing this:

· By clicking on the Connect button on the toolbar

· By selecting Connect from the Connection menu

· By double-clicking on the account tab

· By right-clicking on the foreground tab and selecting Connect from the pop-up menu

· In the Windows 95/NT version, by pressing the Windows Menu key on the keyboard and selecting 
Connect from the pop-up menu

Please note that there is a slight difference in the effect of right-clicking on an account tab in the 
different versions of the program. In the Windows 95/NT version, right-clicking on a tab which isn’t 
selected has the effect of the selecting the tab, bringing it to the foreground and displaying the pop-up 
menu; in the Windows 3.x version, it is necessary to select the required tab by left-clicking on it 
before using the right hand mouse button to display the pop-up menu.

Note that connecting using any of these methods does not cause your system to dial-up and make a 
connection to your ISP unless your winsock has been configure to “dial on demand”: the primary 
function of the Connect action is to connect to a POP3 server, not to make your PC establish a 
connection to the Internet.

It is inadvisable to try and connect to a POP3 server when your system is not online to an ISP: what 
happens then is that Scan Mailbox attempts to perform a DNS lookup to translate the POP3 server 
name into an IP address by making a call on the winsock. The winsock may take several minutes to 
decide that it cannot complete this action before eventually timing out and Scan Mailbox will be 
unresponsive during this time. The timeout period is determined by the winsock and Scan Mailbox 
cannot influence it

If a password was not entered while configuring the account details, the program asks you to enter the 
POP3 password. The password is displayed on the screen as a series of asterisks for security reasons 
and is discarded as soon as Scan Mailbox has connected to the POP3 server. The password can be 
saved for future use, if required, by selecting Accounts from the File => Configure menu and typing 
the password twice into the appropriate boxes.
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The Status line near the lower edge of the window shows the current status of the program, the 
currently active POP3 command (if any) and a “Connected” marker which is displayed while the 
program is connected to a POP3 server.

When the Connect button is clicked, Scan Mailbox connects to the POP3 server and displays details of
incoming mail on the connected account tab. As soon as the connection is established the connect 
button in the toolbar changes to a Disconnect button and the yellow status indicator on the account tab
changes to red.

Unless the account has been configured on the Retrieve tab in Account Options not to retrieve 
message details, the program retrieves details of the waiting mail messages and displays them in the 
mail list on the account tab.

The mail list contains three fixed columns which illustrate the status of each message.

The first column denotes the status of the message on the server:

the message is available on the server and will be left on the server after 
disconnection

the message is available on the server but is marked to be deleted. Unless the 
message is undeleted by the user before disconnection, it will be deleted on the 
server when the program disconnects

the message has been deleted on the server and is no longer available

The second column shows whether the message is selected:

A green pointer is displayed if this message is selected. Delete and Save functions 
apply to all messages which are marked as selected but Display functions apply to a 
single selected message

The third column denotes the status of the message on the local system:

Red symbols indicate that the message has not been displayed or saved:

No part of the message has been retrieved. This symbol is seen only if header 
retrieval is switched off on the Retrieve tab in Account Options

The message headers have been retrieved

Blue symbols indicate that the message has been displayed to the screen:

Message headers have been displayed

The headers and part of the body have been displayed

The full message has been displayed
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Green symbols indicate that the message has been saved to a file:

Message headers have been saved

The headers and part of the body has been saved

The full message has been saved

The remaining columns in the mail list display information about each mail message. The program’s 
default action is to display the message number, the size of the mail message in characters, the name 
of the addressee, the name of the sender and the subject. The Mail List tab in Account Options 
allows the user to select the information to be displayed in the mail list and these may be changed at 
any time, even while connected to a POP3 server.

If the user has chosen not to retrieve message details automatically by unchecking boxes on the 
Retrieve tab in Account Options, some or all of the three ‘Retrieve’ buttons in the toolbar will be 
enabled and the corresponding details can be retrieved under manual control by clicking these buttons.
The ‘Retrieve’ buttons are disabled for the current connection after use.

There is a mail list associated with each tab, so it is possible to review the results of previous 
connections to other accounts simply by clicking on the required tab at any time, even while a tab is 
connected to the server.

Demon users should note that it may take some time for details of waiting messages to appear in the 
mail list, particularly if there are a large number of messages waiting on the server. This delay occurs 
because Demon’s POP3 server is a rather clever pseudo-server: when a user connects to it, it extracts 
details of waiting mail from the SMTP delivery queue and creates a POP3 mailbox dynamically. The 
delay is generally unnoticeable with a few waiting messages but can be significant when many 
messages are waiting.

Note that the mail list box can be scrolled vertically if there are too many messages to be displayed at 
once and that the width of each field in the table can be adjusted by clicking the mouse on a field 
boundary in the header line and dragging the boundary to the left or to the right.

Scan Mailbox disconnects automatically if there are no messages waiting on the server.
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6. Selecting Mail Messages
When Scan Mailbox has finished retrieving and displaying a list of messages on the server, you may 
need to select one or more of the messages in order to display them, mark them to be deleted or save 
them to a file.

The usual Windows techniques for selecting items have been provided and these are summarised 
below.

Using the mouse

Left click Selects the message under the mouse cursor and deselects all 
other messages

<Shift> + left click Deselects all messages and re-selects messages inclusively 
between the message which was selected first and the message 
under the mouse cursor

<Control> + left click Leaves selected any messages which were already selected and 
either deselects the current message if it was already selected or 
selects the current message if it was unselected

Right click with or without the <Shift> or <Control> keys

Windows 95/NT:

If no messages are already selected, selects the current message,
moves focus to this message and displays the context (Message) 
menu

If a single message is already selected, deselects that message, 
selects the current message, moves focus to this message and 
displays the context menu.

If more than one message is already selected,

(a) if the user has right-clicked on one of the selected messages, 
leaves all selected messages selected and displays the 
context menu

(b) if the user has right-clicked on a message which is not 
already selected, deselects all selected messages, selects the 
current message, moves focus to this message and displays 
the context menu

Windows 3.x:

Displays the context menu without changing the selected status 
of any messages
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Using the keyboard

Up/down keys without If no messages are selected, moves focus only. If one or more
any other keys messages are already selected, selects the previous/next message

and deselects all other messages (this is equivalent to a left 
mouse click)

<Control> + up/down keys Moves focus but retains any selections

<Shift > + up/down keys Moves focus up/down, deselects all messages and re-selects 
messages inclusively between the message which was selected 
first and the current message (this is equivalent to <Shift> + left 
mouse click)

 <Space> Selects the current message and retains selections

<Control>+<Space> If the current message is unselected, selects it. If the current 
message is selected, deselects it. In both cases, any other 
selections are retained

<PgUp> and <PgDn> Moves focus up/down by the number of messages displayed in 
the list, deselects all rows and reselects the first/last row on 
display

<Control> + <PgUp> or <PgDn> Moves focus up/down by the number of messages displayed in 
the list but retains selections

<Shift> + <PgUp> or <PgDn> Moves focus up/down by the number of messages displayed in 
the list, deselects all messages and re-selects messages 
inclusively between the message which was selected first and 
the current message

<Home> and <End> Moves focus to the first/last message displayed in the list, 
deselects all rows and reselects the first/last message

<Control> + <Home> or <End> Moves focus to the first/last message displayed in the list but 
retains selections

<Shift> + <Home> or <End> Moves focus to the first/last message, deselects all rows and re-
selects inclusively between the message which was selected first
and the first/last message
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7. Displaying and Saving Mail
When Scan Mailbox has finished retrieving and displaying a list of mail from the server, the program 
allows you to display the mail headers of a selected message, display the entire message or display 
part of a message. While a message is displayed, you can save it to a file or copy it to the clipboard.

To display a message, select it by clicking with the left-hand mouse button on the required line in the 
list and click on one of the three buttons on the toolbar labelled Display Message Headers, Display 
Part of Message or Display Message. These functions are also available from the Message menu.

Selecting Display Part of Message will display the first ten lines of the body of the message by 
default unless the number of lines to be displayed is changed on the Part Message tab in Global 
Options.

An alternative way of displaying a message is to select it with the right-hand mouse button, or to select
it using the left-hand mouse button and then  press the Windows Menu key. This displays a pop-up 
Message menu listing the functions which can be applied to a message.

A further function is available from the Message menu and from the pop-up menu displayed when the 
right-hand mouse button is clicked. Copy Message Details to Clipboard enables the user to copy to 
the Windows clipboard All Details of Selected Message(s), All Details of All Messages or Fields of 
Selected Message. The latter menu item copies the To, Envelope To, From, Envelope From, 
Subject or Size fields from the display of the currently selected message.

This feature enables Scan Mailbox to be used in conjunction with an SMTP server which is able to 
bounce unwanted mail messages: use Scan Mailbox to identify junk mail, use this feature to capture 
the ‘From’ field and then paste it into the SMTP server’s bounce list. Be aware, though, that it is 
trivial for the sender of junk mail to forge the ‘From’ header and that the more competent spammers 
can forge the SMTP envelope, so it is unwise to rely on the accuracy of these fields.

Message details are written to the clipboard with tab characters separating each field and with 
<CR><LF> separating each line. This format is suitable for pasting into a word processor and into 
most spreadsheets.

The default font used to display messages is MS Sans Serif, 10 point. This may be changed by 
selecting Font and Style from the Format menu in the window used to display messages and 
choosing from those fonts available on your system, together with the style (Regular, Italic, Bold or 
Bold Italic) and size. The chosen settings are remembered by Scan Mailbox and will be used to display
messages thereafter.

While a mail message is on display, its contents may be saved to a text file by selecting Save As … 
from the File menu. If the file specified in the Save As … dialogue already exists, the message being 
saved is appended to the existing file. The program remembers the selected directory and file name 
and offers these as the default when the dialogue is next entered.

After a default directory and file name have been selected in the Save As … dialogue, the mail 
message on display may be appended to that file by selecting  Save from the File menu.

Messages are saved in RFC-822 (unix) format and may be imported into any mail program which 
recognises this format, such as Agent and Turnpike. If you wish to import mail messages saved by 
Scan Mailbox into a mail program which doesn’t provide the ability to import mail, an alternative way
of doing this is to run a local POP3 server program which reads the files saved by Scan Mailbox and 
offers a POP3 interface to your mail program. A suitable free POP3 server is TPOP3 and this is 
available from:

Page 16 of 56



POP3 Scan Mailbox - Version 1.0

ftp://ftp.demon.co.uk/pub/ibmpc/win3/winsock/apps/tpop/tpop3v04.zip

Alternatively, the message may be captured by marking all or some of the displayed text, either by 
clicking and dragging the mouse or by choosing Select All from the Edit menu, and then copying the 
selected text to the Windows Clipboard by selecting Copy from the Edit menu. The copied text can be
imported into Windows Notepad or a word processor by using Edit and Paste.

Short-cuts are provided to some of the functions on the Message menu and the result of double-
clicking on a message is configurable by means of the Double Click tab in Global Options.

The program has the capability of saving one or more messages to a file in a single operation without 
displaying them to the screen. To save all messages to a file, click on the toolbar button labelled Save 
All Messages or select the Message menu, then Save Messages to File and All Messages. To save a 
range of messages to a file, select the range by clicking on the first message to be saved with the left 
mouse button, hold down the SHIFT key and click on the last message to be saved (see section 6). 
Save the messages by clicking on the toolbar button labelled Save Selected Messages or select the 
Message menu, then Save Messages to File and Selected Messages. Unless a directory and file name 
has been specified in the Saving tab on the Account Options dialogue or Use Automatic File Names 
has been checked on this tab, a Save As … dialogue is presented in each case to enable selection of a 
file into which the messages will be saved and the directory and filename offered in this dialogue are 
those used previously while saving messages. If the chosen file already exists, the messages being 
saved are appended to the end of the existing file and messages are saved in RFC-822 format suitable 
for importing into another email program. Any messages in the selected range which have been 
marked for deletion are skipped.

Remember that each tab has its own list of mail: it is possible to review the list of messages associated
with another tab which has been connected during the current session simply by clicking on the tab.

Demon users should note that the act of displaying a message with Scan Mailbox marks the message 
as ‘read’ on the POP3 server. This does not affect its subsequent delivery by SMTP, or its availability 
when another POP3 mail program checks for new messages, but it does inhibit Demon from sending a 
‘not yet read’ warning to the sender after 7 days and from bouncing the message back to the sender 
after 28 days. Once a mail message has been displayed by Scan Mailbox, it will be deleted 
automatically by Demon if not collected by SMTP or retrieved and deleted by POP3 within 28 days.
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8. Deleting and Undeleting Mail
If “Mail Kill Active” has been set in the Configure Mail Kill dialogue, Scan Mailbox will have 
already marked for deletion any messages which match the user-specified Mail Kill criteria, unless 
any of the enabled items on the Retrieve tab in Account Options have been unchecked, in which case
mail kill may be performed manually by clicking on the toolbar button labelled Apply Mail Kill 
Rules or by selecting the corresponding item in the Message menu.

If Scan Mailbox has marked for deletion one or more messages which you want to keep, select the 
messages by clicking on them in the mail list, and undelete them by clicking on the toolbar button 
labelled Undelete Selected Messages. To undelete all messages marked for deletion, click on the 
toolbar button labelled Undelete All Messages. Both of these functions are also available from the 
Message menu and from the pop-up menu which appears when right-clicking on the mail list.

If desired, the Mail Kill rules may be amended in the Configure Mail Kill dialogue and the rules re-
applied to the current messages by clicking on the toolbar button labelled Apply Mail Kill Rules or 
by selecting this function from the Message menu.

To delete one or more unwanted mail messages from the delivery queue, select the messages and click
on the toolbar button labelled Delete Selected Messages or select this function from the Message 
menu. A single message is selected by clicking on it with the left-hand mouse button; a range of 
messages are selected by clicking on the first message and then holding down the shift key while 
clicking on the last message; multiple messages are selected by holding down the control key while 
clicking on each message. All messages can be deleted by clicking on Delete All Messages.

An alternative way of deleting selected messages is to click the right-hand mouse button. This displays
a pop-up Message menu listing the functions which can be applied to a message and one of these is 
Delete Messages. This menu item expands to a choice of All Messages and Selected Messages.

If you make a mistake and delete the wrong message or simply change your mind, select the messages 
to be undeleted and click on the toolbar button labelled Undelete Selected Messages or select this 
function from the Message menu. All messages may be undeleted by clicking on Undelete All 
Messages.

It is important to note that no mail message is actually deleted until you disconnect properly from the 
POP3 server: clicking on one of the Delete buttons merely marks the selected messages for deletion 
but gives you an opportunity for second thoughts. No messages will be deleted if the connection to 
your ISP drops before you have disconnected from the server.

If you have an account with Demon and would like to test deleting messages within Scan Mailbox 
without risking inadvertent deletion of wanted mail, you can send mail to yourself via Demon by 
addressing it to:

test%somehost.demon.co.uk@post.demon.co.uk

where “somehost” is your hostname. Mail addressed in this way will be delivered back to you by 
Demon addressed to test@somehost.demon.co.uk so you can tell Scan Mailbox to connect to the 
server using a user name of “test” and experiment with deleting mail without any risk.
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9. Disconnecting from the Server
There are several ways of disconnecting from the POP3 server:

· By clicking on the Disconnect button on the toolbar

· By selecting Disconnect from the Connection menu

· By double-clicking on the account tab

· By right-clicking on the foreground tab and selecting Disconnect from the pop-up menu

· In the Windows 95/NT version, by pressing the Windows Menu key on the keyboard and selecting 
Disconnect from the pop-up menu

If any messages have been marked for deletion, Scan Mailbox gives you one last chance to change 
your mind by asking whether you really want to delete them. Answering “Yes” deletes the marked 
messages irrevocably and disconnects; answering “No” leaves you connected to the server and 
undeletes all messages; answering “Cancel” leaves you connected to the server with those messages 
which have been marked for deletion still marked.

When disconnection is complete, the status indicator on the tab changes from red to green, showing 
that this tab has been used in the current session.

Occasionally, a POP3 server may stop responding and Scan Mailbox may appear to be hung. If this 
happens, click on the Disconnect button and the program will send “QUIT” to the server in an attempt
to disconnect cleanly. If the POP3 server fails to react to this, clicking on Disconnect a second time 
forces an immediate disconnection. In the event of a forced disconnection, mail messages which have 
been marked for deletion may not actually be deleted.

The list of mail waiting on the server remains associated with the selected tab until you connect again 
using the same tab or until the program is closed down
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10. Global Options
Several aspects of Scan Mailbox may be customised by selecting from a range of options. Some of 
these are provided as Global options, which apply to the program as a whole, and some are provided 
as Account Options, which apply to the selected account tab.

The Global Options dialogue is displayed by clicking on the toolbar button labelled Global Options 
or by selecting File and then Global Options from the menu. This allows the following aspects of the 
program to be customised by clicking on each tab:

Double Click on Message Action

This tab determines the effect of selecting a message from the mail list by double-clicking with 
the mouse. Depending on the option selected, double-clicking has one of the following effects:

Display Message Headers The message headers are displayed.

Display Message The entire message is displayed.

Display Part Message Part of the message is displayed.

Copy ‘From’ field The ‘From’ field from the display of the currently selected 
message is copied to the Windows clipboard.
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Part Message

This tab determines the action of the Part Message command.

Display <n> lines of message Enter in this box the number of lines you wish to display 
from the body of the message.

Without the Headers When this option is selected, headers are not displayed.

With the Headers When this option is selected, headers are displayed in 
addition to the requested numbers of lines from the body of 
the message.
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Log Files

This tab determines whether new log files are created each time the program is run. The session
log file is named “log.txt” and records the dialogue between the program and the POP3 server. 
The Mail Kill log file is named “logkill.txt” and records details of mail messages deleted 
because they match one of the user-supplied mail kill criteria. Both log files are created in the 
Scan Mailbox directory.

Create new log files each time The log files are overwritten each time the program is 
started. This is the default.

Append to existing log files The log files are appended on each run of the program. This 
option should be used with care because the log files will 
grow without limit and they should be deleted or archived 
periodically.

Set Logging Level: Enter in this box a number between 0 and 4 to control the 
amount of information recorded in the session log file.

The effect of each logging level is as follows:

0 : no logging at all. This is the default.

1 : comments only. This comprises a timed narrative 
describing the actions performed by the program.

2 : contents of the mail list grid after retrieving message 
details from the server

3 : POP3 commands issued by Scan Mailbox with the first 
and last lines of the response from the server

4 : full responses from the server, including the headers of 
all messages and the body of all messages which are 
retrieved by the user.
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Logging levels are additive in the sense that level 2 includes 
level 1, level 3 includes levels 1 and 2, and so on.

Account Tabs (Windows 95 and NT versions)

This tab affects the appearance of the Account Tabs when there are too many of them to be 
displayed in a single row.

Single scrollable row of tabs Account Tabs are displayed in a single row with scroll 
buttons to enable the tabs to be scrolled horizontally.

Multiple rows of tabs Account Tabs are displayed in multiple rows.
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Account Tabs (Windows 3.x version)

This tab affects the appearance of the Account Tabs when there are too many of them to be 
displayed in a single row.

Number of tabs per row This value defaults to 4, but can be set to any value between 
1 and 6. It controls the number of tabs displayed in each row 
and therefore the number of rows of tabs. Decrease this 
value if you find that the tab names are truncated due to lack
of space on the tab header.
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Miscellaneous

This tab controls several miscellaneous program functions:

Resize mail list columns automatically This option determines whether Scan Mailbox sets
the width of columns in the mail list itself or 
whether it should leave the user to set the widths.

If this option is unchecked, the user may alter the 
column widths manually by positioning the mouse
on a column boundary in the grid header line and 
dragging the mouse to the desired width. 
Scan Mailbox will remember the chosen widths 
and re-instate them each time it starts. It will not 
change the column widths when the window size 
is changed. Note that automatic resizing is still 
done when a column is added to or removed from 
the display.

Scroll the mail list automatically If checked, the mail list is scrolled automatically 
in a vertical direction while retrieving message 
details.

Display the toolbar The toolbar is displayed by default. Uncheck this 
item to suppress the toolbar.
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11. Account Options
Account Options enable the user to customise the action of Scan Mailbox for each account tab.

The Account Options dialogue for a particular account tab is displayed by clicking on the required tab
to bring it to the foreground and then:

· Clicking on the Account Options button on the toolbar

· Selecting Account Options from the Connection menu

· Right-clicking on the account tab and selecting Account Options from the pop-up menu

The Account Options allows the following aspects of the program to be customised by clicking on 
each tab:

Mailer

This option determines whether Scan Mailbox starts another program or instructs another mail 
program to download email when Scan Mailbox disconnects from a POP3 server. Scan Mailbox
invokes the programs specified on this tab only if mail messages remain on the server.

Pressing and holding the SHIFT key while initiating a disconnect inhibits Scan Mailbox from 
invoking the programs specified on this tab.

Start another program When checked, Scan Mailbox starts the program specified in the
on disconnection the ‘Program Path’ box when it disconnects from a POP3 server.

Program Path: Enter in this box the full path to the program to be started.
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If the path name contains embedded spaces, such as in ‘c:\
Program Files\…’, the path name must be surrounded by double 
quote characters. These quote characters, if used, should be 
positioned around the program path but not around any 
command line arguments. The quote characters may be 
specified, but are not required, if there are no embedded spaces 
in the path.

The following are examples of valid entries in this field:

“c:\Program Files\agent\agent.exe” c:\AgentData\Demon
“c:\Program Files\agent\agent.exe” c:\Data Files\Demon
“d:\Program Files\pegasus\winpm-32.exe” -i mike
c:\apps\pegasus\winpm.exe -i mike

Working Directory: Enter in this box the working directory for the program. 
Embedded spaces are permitted in this field and quote 
characters should not be used.

Wait for <n> seconds This option is available only when ‘Send command to
 before sending command another program on disconnection’ is checked. Its purpose is 

twofold:

First, it enables the user to specify that a program should be 
started by Scan Mailbox and that a keyboard command 
sequence should be sent to the same program after allowing 
sufficient time for it to start. Enter in the box a time between 1 
and 30 seconds which is sufficient for the program to start and 
be ready to accept a command.

Secondly, it allows the user to specify that Scan Mailbox should 
wait for a few seconds after disconnecting from the POP3 server
and before sending a keyboard command sequence to a mail 
program which is already running. This may be necessary when 
Scan Mailbox is used with POP3 servers which are slow to 
disconnect. If the POP3 server returns an error message to your 
mail program saying that another connection is open, check this 
box and specify a delay of a few seconds.

Send command to another When checked, Scan Mailbox sends the specified keyboard
program on disconnection sequence to the mail program named in the ‘Program title bar’ 

box. The other mail program must be running at the time that 
Scan Mailbox attempts to communicate with it.

Program title bar Enter in this box the name of the mail program to be activated 
as shown in the title bar of its window. Scan Mailbox looks for 
an exact match between the string entered into this box and a 
window title unless one or more wildcards are specified. The 
simplest way of specifying a program name is to enter sufficient
characters to identify the program uniquely followed by an 
asterisk. Case is significant.
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Permissible wildcards are:

? Any single character

* Zero or more characters

# Any single digit

[charlist] Any single character in charlist

[!charlist] Any single character not in charlist

A group of one or more characters (charlist) enclosed in 
brackets ([ ]) can be used to match any single character in the 
window title and can include almost any character code, 
including digits.

The special characters left bracket ([), question mark (?), 
number sign (#), and asterisk (*) can be used to match 
themselves directly only by enclosing them in brackets. The 
right bracket (]) can’t be used within a group to match itself, but
it can be used outside a group as an individual character.

In addition to a simple list of characters enclosed in brackets, 
charlist can specify a range of characters by using a hyphen
(-) to separate the upper and lower bounds of the range.
For example, [A-Z] results in a match if the corresponding 
character position in the string contains any of the uppercase 
letters in the range A to Z. Multiple ranges are included within 
the brackets without any delimiters.

Note that Scan Mailbox does not start the named application; if 
it is not running when Scan Mailbox disconnects from the POP3
server, this option has no effect.

Keys to be sent These boxes determine which command keys are sent to the 
named application. The keys to be sent activate a menu item or 
are interpreted as a keyboard short cut to a particular function. 
Which keys should be sent depend on the mail program to be 
activated.

Check the ALT box to send the <ALT> key, check the CTRL 
box to send the <CTRL> key and enter the remaining characters
to be sent in the third box.

Command characters to start common mail programs 
downloading mail are as follows:

Agent: ALT OE or CTRL E
Pegasus: ALT FC
Eudora: ALT FM or CTRL M
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Retrieve

These options can be set in any combination and determine which message details 
Scan Mailbox retrieves from the POP3 server automatically when a connection is made. If an 
item is checked, the corresponding details are retrieved automatically; if unchecked, the details 
are not retrieved unless the program is told to do so while online by means of the items in the  
Online menu or by clicking the corresponding toolbar buttons. 

Unchecking these items is one way of coping efficiently with mail bombs, where many, 
perhaps thousands, of unwanted messages are sent to you.

The options have the following effect:

Retrieve Message Sizes When checked, Scan Mailbox automatically retrieves the 
size of each mail message awaiting collection when it 
connects to the POP3 server.

When unchecked, message sizes are not retrieved and the 
‘Size’ field in the mail list is left blank unless and until 
message sizes are retrieved under manual control. To do this 
while online, click on the toolbar button labelled Retrieve 
Message Sizes or select this item from the Online menu.

This item is checked by default.

Retrieve Headers When checked, Scan Mailbox automatically retrieves the 
headers of all mail awaiting collection when it connects to 
the POP3 server. It needs to do this in order to extract 
information from message headers to display in the mail list 
grid.

It is not advisable to do this on a dial-up connection if there 
are many thousands of messages on the server because the 
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headers alone can occupy several Megabytes and take a long
time to retrieve.

When this option is unchecked, Scan Mailbox suppresses 
retrieval of message headers and retrieves only the size of 
each message from the server (if Retrieve Message Sizes is 
checked) and the SMTP envelope (depending on the setting 
of the option described below). This action is very much 
faster than retrieving all the headers but does not allow 
display of any information about the messages apart from the
message number and message size.

When unchecked, message headers are not retrieved and the 
remaining fields in the mail list are left blank unless and 
until message headers are retrieved under manual control. To
do this while online, click on the toolbar button labelled 
Retrieve Headers or select this item from the Online menu.

This item is checked by default.

It may seem at first sight that a display of message sizes only
is of little use. But certain types of mail bomb contain many 
identical messages and displaying just the message size may 
be sufficient to identify the unwanted messages and mark 
them for deletion.

Retrieve SMTP Envelope This option is relevant only when the POP3 server supports 
the “*ENV” command. At the time of writing, only Demon 
Internet in the UK support this command.

When checked, Scan Mailbox automatically retrieves the 
SMTP envelopes of all mail awaiting collection when it 
connects to the POP3 server. This enables display in the mail
list of message number, SMTP ‘From’ value and SMTP ‘To’
value

When unchecked, SMTP envelopes are not retrieved and 
these fields in the mail list are left blank unless and until 
SMTP envelopes are retrieved under manual control. To do 
this while online, click on the toolbar button labelled 
Retrieve Envelopes or select this item from the Online 
menu.

This item is checked by default if Server supports *ENV is 
selected on the Server tab; otherwise, it is disabled.

Note that retrieving the SMTP envelope for each message is 
considerably slower than simply retrieving a list of message 
sizes, but is very much faster than retrieving all the message 
headers.
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Mail List

These options allow you to select which mail attributes are displayed in the mail list. Check the
items which you want to be displayed; uncheck those items which you do not want displayed.

There are a few points to note about these options:

· The ‘Date’ and ‘Time’ values are extracted from the ‘Date:’ header of the mail message. If 
this header is malformed, the current date and time are displayed instead.

· The ‘Envelope From’ and ‘Envelope To’ values are taken from the SMTP envelope which is
available only when an account is used with a server which supports the ‘*ENV’ POP3 
extension. At the time of writing, only Demon Internet’s POP3 server implements this 
command.

· These options may be changed at any time, even while Scan Mailbox is connected to a 
POP3 server, and the mail list will be updated to reflect the new selection.
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Saving

Use of this option enables mail to be saved in different files after being downloaded from the POP3 
server, depending on the account tab in use and, optionally, on the addressee. If the fields on this tab 
are left blank, any messages retrieved from the server will be appended to the file last used for saving 
mail messages. If the fields are left blank and no messages have been saved to file before, the program
asks for the name of a file to be used.

To specify a file name on this tab, enter the name of a directory in the Directory field and the name of
a file in the File Name field.

When the box labelled Use Automatic File Names is checked, the file name used when saving 
messages is derived from the addressee of the message. If SMTP envelope details are available, the 
file name is constructed from the user name specified in the ‘RCPT TO’ envelope value; otherwise, 
the filename is constructed from the user name specified in the ‘To:’ header of the message. In both 
cases, the file name is constructed from the first (up to) eight alphanumeric characters of the user 
name.

When saving messages to a file with Use Automatic File Names switched on, the program will save 
messages addressed to <user 1> in the file used for <user 2>’s messages if one or more lines are 
inserted in the ‘scanmail.ini’ file with the format:

Alias=<user1>,<user2>

For example, the line:

Alias=smb,scanmail

causes messages addressed to ‘smb’ to be saved as if they had been addressed to ‘scanmail’. 'Alias' 
lines may be entered at any point in the ‘scanmail.ini’ file. They have a global effect (across all 
account tabs). There is no corresponding means of setting or changing aliases within the program.
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The Use Automatic File Names feature may be of particular interest to those who wish to use 
Scan Mailbox to download mail from a POP3 server which places mail for a number of different user 
names in one POP3 mailbox. For example, mail addressed to mike.ashton@somehost.isp.com, 
julie_23@somehost.isp.com and ScanProgList@somehost.isp.com will be saved in files named 
mikeasht.txt, julie23.txt and scanprog.txt respectively.

In all cases, new mail is appended to the file if it already exists (else the file is created) and is written 
in a format which is suitable for importing into mail programs which accept mail files in the standard 
‘unix’ format. Mail files written by Scan Mailbox are also suitable for use with local POP3 servers 
which accept ‘unix’ format, such as TPOP3.
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Mail Kill

The options on this tab determine how Mail Kill Accept criteria are compared with message attributes.

If the Headers check box is checked (this is the default), Accept rules are applied to the mail header: 
the Addressee Accept list operates on the ‘To:’ and ‘Cc:’ headers of incoming mail and the Sender 
Accept list operates on the ‘From’ header.

If the SMTP Envelope check box is checked, Accept rules are applied to the envelope values: the 
Addressee Accept list operates on the ‘RCPT TO’ value and the Sender Accept list operates on the 
‘MAIL FROM’ value. This item is available only when ‘Server Supports *ENV’ is selected in the 
Server tab which effectively limits this to Demon Internet accounts.

If both check boxes are checked, Accept rules are applied both to header fields and envelope values.

Note that different settings may be chosen for each account tab.

Applying Accept rules to mail headers provides the greatest discrimination when one email identity is 
used for many purposes. Applying Accept rules to the SMTP envelope provides greatest 
discrimination when separate posting identities are used for different purposes, such as posting to 
usenet newsgroups where the email address may be captured by junk mailers.
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Server

These options are used to tell Scan Mailbox whether the POP3 server supports an extension to 
the POP3 protocol which is used to retrieve SMTP envelope values, and whether it correctly 
implements the ‘TOP n 0’ command.

Server supports *ENV

This box is unchecked by default and should be left unchecked for use with all ISPs except 
Demon Internet. If it is checked by mistake, Scan Mailbox will report protocol errors while 
talking to the POP3 server.

Demon’s POP3 server supports a non-standard extension to the POP3 protocol which enables a 
POP3 client to extract the ‘MAIL FROM’ and ‘RCPT TO’ values from the SMTP envelope. 
These are more reliable than the ‘From:’ and ‘To:’ values in the mail header and can be 
displayed in the mail list as well as, or instead of, these values. Envelope values will be 
retrieved from the server if this box is checked when used with Demon Internet. Whether they 
are displayed in the mail list depends on the settings in the Mail List tab.

Server supports TOP n 0

Scan Mailbox retrieves the headers of message number n from the server by issuing the POP3 
command ‘TOP n 0’. Some servers wrongly respond to this command by returning the entire 
message. To cope with these non-compliant servers, Scan Mailbox has the capability of using 
the command ‘TOP n 1’ instead (which requests the headers and the first line of the message 
text). This command is more likely to be interpreted correctly by broken servers.
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To check whether your ISP’s POP3 server implements ‘TOP n 0’ correctly, set the Logging 
Level to 4 on the Log Files tab in Global Options and examine the session log file ‘log.txt’ 
after a connection to the server. Look in this file for the command ‘TOP n 0’ issued by the 
program and examine the server’s response. If the server responds to this command with the 
message headers only, it correctly implements the ‘TOP n 0’ command and this item should be 
left checked. However, if the server responds with the entire message, uncheck this item and 
the program will use ‘TOP n 1’ instead.

Alternatively, perform a Display Message Headers operation while connected to the POP3 
server. If message headers are displayed without the body of the message, the server supports 
‘TOP n 0’ and this option should be left checked. However, if the full message is displayed, the
server does not support ‘TOP n 0’ and this option should be unchecked.
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12. Menus
All program functions available from the toolbar on the main screen are duplicated in the menus, 
which also allow access to other functions.

Menu functions are:

FILE MENU

Configure

Accounts … Displays the Account Configuration dialogue 

Mail Kill … Displays the Mail Kill Configuration dialogue

Global Options … Displays the Global Options dialogue

Always on Top This option (marked with a check when selected) 
keeps the Scan Mailbox window on top of any other
windows displayed on the screen

Exit Exits from the program

ACCOUNT MENU Lists the account names which have been 
configured and brings to the foreground the 
corresponding account tab, as an alternative to 
selecting an account by clicking on the tab.

CONNECTION MENU

Connect Duplicates the Connect button

Disconnect Duplicates the Disconnect button

Account Options … Displays the Account Options dialogue

Note that the Connection menu is displayed as a pop-up menu when the right mouse 
button is clicked while positioned over an account tab.

VIEW MENU This menu is displayed only if the program is started
using the ‘/OV’ command line option, and provides 
a means of viewing the Scan Mailbox configuration,
message and log files.
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ONLINE MENU

Retrieve Envelopes Retrieves SMTP envelopes while online

Retrieve Message Sizes Retrieves message sizes while online

Retrieve Headers Retrieves message headers while online

These menu items are enabled only if the corresponding options on the Retrieve tab of 
Account Options are unchecked, and are disabled, once used, for the current 
connection.

MESSAGE MENU

Display Message Headers Displays the headers of the selected message

Display Message Displays all of the selected message

Display Part of Message Displays the headers of the selected message and 
part of the message body

Save Messages to File

All Messages Saves all messages to a file

Selected Messages Saves selected messages to a file

Apply Mail Kill Rules Applies the current set of Mail Kill rules to the 
messages on display

Select All Messages Selects all messages in the mail list

Delete Messages

All Messages Marks all messages for deletion

Selected Messages Marks selected messages for deletion

Undelete Messages

All Messages Undeletes all messages

Selected Messages Undeletes selected messages

Copy Message Details to Clipboard

All Details of Selected Messages

Copies all the available details of the selected 
messages to the Windows clipboard. Message 
details are written to the clipboard with a tab 
character separating each field
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All Details of All Messages

Copies all the available details of all the messages 
to the Windows clipboard. Message details are 
written to the clipboard with a tab character 
separating each field and with <CR><LF> 
separating each line. This format is suitable for 
pasting into a word processor or spreadsheet

Fields of Selected Message

To Copies the ‘To’ field of the selected message to the 
Windows clipboard

Envelope To Copies the ‘Envelope To’ field of the selected 
message to the clipboard

From Copies the ‘From’ field of the selected message to 
the clipboard

Envelope From Copies the ‘Envelope From’ field of the selected 
message to the clipboard

Subject Copies the ‘Subject’ field of the selected  message 
to the clipboard

Size Copies the ‘Size’ field of the selected message to 
the clipboard

Note that the Message Menu is displayed as a pop-up menu when the right-hand mouse 
button is clicked while positioned over the mail list.
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HELP MENU

Contents Invokes Windows Help and displays the Help 
Contents

Search for Help On … Invokes Windows Help and displays the Help 
Topics

Manual

Word Format Displays this manual in Word format within 
whatever program is associated with the ‘.doc’ file 
extension. Word 6 or later is recommended.

PDF Format Displays this manual in PDF format within whatever
program is associated with the ‘.pdf’ file extension. 
Acrobat Reader V3.0 or later is recommended.

Release Notes Invokes Windows Help and displays the Release 
Notes which contain information about recent 
changes to Scan Mailbox and the “wish list” of 
suggested enhancements.

About Displays Scan Mailbox version information

Note that the Manual sub-menu is displayed only if both Word and PDF versions of the 
manual exist in the Scan Mailbox directory. If you prefer to use one or the other version 
of the manual, simply delete, or move out of the Scan Mailbox directory, the version 
which you do not want to use. Selecting Manual from the Help menu will then display 
only whichever manual is present in the Scan Mailbox directory.
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13. Command Line Options
Scan Mailbox recognises several optional command line parameters which allow automatic connection
to POP3 servers and control aspects of the program’s behaviour. These are:

/C <account Name> When specified, Scan Mailbox will connect automatically to the 
POP3 server associated with the named account, and lists mail 
waiting, as soon as it is started.

Note that this option does not initiate a dial-up connection to your 
ISP: it simply connects to the POP3 server assuming that a 
connection to the ISP has already been established.

/I This option is provided for use in insecure environments such as 
Cyber Cafés and ensures that Scan Mailbox is configured each time
it starts so that no details of accounts and passwords are left on the 
system after use. Specifically, when this option is used:

The ‘scanmail.ini’ file is deleted when the program closes down 
and, if it exists, when the program starts. This forces the user to 
input an account name and POP3 server name whenever 
Scan Mailbox starts.

The ‘Welcome’ screen, which is normally displayed whenever 
Scan Mailbox is started without an ‘.ini’ file, is bypassed and the 
program opens in the Account Configuration dialogue.

Entry of a password into the Account Configuration dialogue is 
disallowed and the program asks for a password to be entered 
whenever the user connects to a POP3 server.

/K If present anywhere on the command line, automatic Mail Kill is 
switched on for the duration of the automatic connections.

If this option is not specified, automatic mail kill is inactive during 
automatic connections, regardless of the setting of the switch in the 
Mail Kill dialogue.

/OV If this option is specified, the normally hidden View menu is 
displayed.

/S By default, Scan Mailbox disconnects from the POP3 server after 
an automatic connection. Specifying this option at the end of the 
command line causes Scan Mailbox to stay connected to the last 
Account specified.

/W<n> This option controls whether Scan Mailbox starts in a normal 
window, minimised or maximised. If this option is not specified, 
Scan Mailbox starts in whatever window state it was in when it was 
last closed down.

/W0 Start in a normal window.
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/W1 Start minimised. This value may be useful when Scan Mailbox is 
started from a scheduler: it causes minimum disruption if the 
computer is being used for other purposes at the time.

/W2 Start maximised.

/X If present anywhere on the command line, Scan Mailbox closes 
down after a series of automatic connections if there is no mail 
waiting at any of the checked Accounts.

If there is mail waiting, the program stays running so that the user 
can check the lists of mail.

This allows Scan Mailbox to be used to check infrequently used 
email accounts and draw the user's attention (by remaining open) if 
there is waiting mail at any of them.

/Z If present anywhere on the command line, Scan Mailbox closes 
down unconditionally after a series of automatic connections.

This allows Scan Mailbox to be started from a scheduler, such as 
Dunce, and run unattended, perhaps with Mail Kill active.

Command line options may be separated by one or more spaces. Options are validated when 
Scan Mailbox starts; if any of them is invalid or not recognised, an error message is displayed on the 
screen, further details are written to the “log.txt” file and no options are used.

Please note that account names are case-sensitive: if an account has been configured in the program 
named ‘Demon’, a command line argument of “/C demon” will not be recognised

If you have several POP3 accounts, perhaps on different POP3 servers, it is possible to connect 
automatically to several accounts, one after the other, by placing several /C options on the command 
line.

A few examples: suppose that you have configured an account called “Demon”.

/C Demon will automatically connect to the server, list all mail 
waiting for your host and disconnect from the server

/C Demon /K will automatically connect to the server, list all mail 
waiting for your host and action automatic Mail Kill 
before disconnecting from the server

/D Demon /K /S will automatically connect to the server, list all mail 
waiting for your host, action automatic Mail Kill but 
leave the program connected to the server, giving you
an opportunity to review mail marked for deletion and
“undelete” killed mail if you so choose

/C Demon /X will automatically connect to the server, list 
all mail waiting for your host and close down the 
program if there is no mail waiting

/C Demon /Z will automatically connect to the server, list all mail 
waiting for your host and close down the program 
unconditionally
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If you have configured two other accounts called “Netcom” and “Virgin”,

/C Demon /C Virgin /C Netcom will automatically connect to each account in turn, 
list mail waiting at each account and disconnect from 
each server

/C Virgin /C Demon /S will automatically connect to the Virgin account, list 
mail waiting there, then connect to the Demon 
account, list mail waiting there and stay connected

Be aware that Mail Kill is activated on automatic connections only if the /K option is specified, 
regardless of the state of the mail-kill switch in the Mail Kill Configuration dialogue. Note that 
automatic serial connections to several accounts with Mail Kill switched on does not give you a 
chance to review mail marked for deletion and change your mind about deleting it unless you connect 
automatically to a single account and specify the /S option.

Also note that the “/C” option does not dial up your ISP but simply connects to the POP3 server, 
assuming your computer is already connected to the Internet. You should arrange to connect to your 
ISP independently of Scan Mailbox.

While performing a series of automatic connections, error messages requiring acknowledgement by 
the user are not displayed but any errors are reported to the session log file. This enables Scan Mailbox
to be used unattended for automatic connections.

A simple way of using command line options is by setting up one or more shortcuts on the Windows 
desktop. To do this on Windows 95, right click on the desktop and select New and then Shortcut. 
Browse to find the scanmail.exe program, click on the program name and then on Open. After 
scanmail.exe at the end of the displayed line, type the required options and click on Next. Finally, 
choose a name for the shortcut and click on Finish. Whenever you double click on the shortcut, 
Scan Mailbox will start with the options specified.
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14. Automatic Mail Kill 
Scan Mailbox supports the use of Automatic Mail Kill. This is a mechanism which allows the user to 
specify that certain types of mail are unwanted and should be deleted automatically by Scan Mailbox 
before delivery. The user can also specify that certain types of mail are wanted by using ‘Accept’ 
rules. Mail can be accepted based on its addressee, sender and subject and can be killed based on its 
length, addressee, sender, subject and on whether it fails to match an Accept rule. Accept rules are 
applied before Kill rules and take precedence over them. Thus a message will be accepted if it 
matches an Accept rule even if it would otherwise match a Kill rule. Both Accept and Kill rules are 
applied to each message in the order addressee, sender and subject.

The Mail Kill configuration window is displayed by selecting Mail Kill from the Configure menu 
which is under the File menu.

To switch on Automatic Mail Kill, click in the box marked Mail Kill Active and ensure that a check 
mark appears.

When retrieving a list of waiting mail from the server, Scan Mailbox compares each message first with
a list of Mail Accept criteria, and marks for acceptance any message which matches one or more of 
the user-specified criteria. Each message which has not been marked for acceptance is then compared 
with a list of Mail Kill criteria and marked for deletion if it matches one or more of the user-specified 
criteria. The character strings entered in the Accept and Kill lists are compared with the relevant fields
in the incoming message and a message is accepted or killed if the specified string appears at any 
point in the message field.
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By default, the Addressee lists are compared with the ‘To:’ and ‘Cc:’ mail headers, the Sender lists are
compared with the ‘From:’ mail header and the Subject lists are compared with the ‘Subject:’ mail 
header. 

However, if Server supports *ENV is switched on in the Server tab on Account Options, the 
Addressee and Sender lists may be compared with additional or different values obtained from the 
SMTP envelope: the Kill lists are also compared with the ‘RCPT TO’ and ‘MAIL FROM’ values and 
the Accept lists are compared with either, both or one of the ‘To:’ and ‘From:’ headers and the ‘RCPT 
TO’ and ‘MAIL FROM’ values. This action is set from the Mail Kill tab in Account Options.

Also in this dialogue is a check box labelled “Kill all messages which don’t match ‘Accept’ criteria”. 
This provides a powerful means of identifying and deleting junk mail by relying on the fact that 
almost all junk mail contains a false address in its ‘To:’ header. To use this option, enter in the 
Addressee Accept list details of all your email addresses plus appropriate identifying strings from the 
‘To:’ headers of wanted Mailing Lists, and switch this option on. The only email not accepted will be 
junk mail and mail sent to you using the ‘Bcc’ option in the sender’s email program. Legitimate use of
‘Bcc’ outside Mailing Lists is rare, but this option is not appropriate if you expect to receive wanted 
mail from unknown sources in this way. When this option is switched on, it is recommended that you 
monitor Scan Mailbox’s operation for a while to ensure that the ‘Accept’ lists contain details of all 
wanted mail.

A record of any mail messages killed is written to a file named ‘logkill.txt’ in Scan Mailbox's 
directory.

A few examples may clarify the process.

Suppose you wish to kill any mail sent to you from any user at cyberpromo.com. To do this, simply 
enter ‘cyberpromo.com’ (without the quotes) in the Sender Kill list. It is generally advisable to enter a 
full domain name or full email address in the Sender Kill list. If you intend to kill mail from 
‘basil@junkmail.com’ and enter ‘basil’ as a Sender Kill criterion, mail from ‘basil@junkmail.com’ 
will be killed but so will mail from ‘me@basilica.co.uk’.

If you have a Demon account, your hostname is ‘somehost’ and you wish to kill all mail addressed to 
steve@somehost.demon.co.uk (perhaps the address has been compromised on Usenet and you have 
stopped using it), enter ‘steve@somehost’ or ‘steve@somehost.demon.co.uk’ in the Addressee Kill 
list.

If you want to kill any message which contains the word “money” in its subject, enter “money” in the 
Subject Kill list.

If you want to accept all messages addressed to ‘mike@somedomain.com’, enter the full address in the
Addressee Accept list.

If you would like to accept messages from ‘myfriend@xxx.com’ but kill messages from all other users
of xxx.com, enter ‘myfriend@xxx.com’ in the Sender Accept list and ‘@xxx.com’ in the Sender Kill 
list.

Note that there is an effective wildcard at the start and end of each Kill string and that case is not 
significant, so, for example, a Subject Kill entry of “money” matches messages with Subjects of 
“Make Money Fast” and “money for you NOW!”.
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Killing on Mail Size

If you wish Scan Mailbox to delete any incoming email which is larger than a certain size, click the 
box marked Kill messages longer than … characters so that a check mark appears and enter the 
maximum wanted mail size in the box.

If you wish Scan Mailbox to delete all incoming mail messages of a particular size, click the box 
marked Kill all messages of size … so that a check mark appears and enter the size of the unwanted 
messages in the box. This option is intended to be used to delete mail bombs where many identical 
messages arrive, all of the same size.

Accepting or Killing on Sender

If you wish Scan Mailbox to accept or delete incoming mail based on its origin, click on the Senders 
tab, enter a character string in the box marked Accept Mail From or Kill Mail From and click on 
Apply. Any number of Senders can be entered in these lists. To delete a Sender from one of the lists, 
select the desired entry from the list by clicking on it and click on Delete.

Accepting or Killing on Subject

Page 46 of 56



POP3 Scan Mailbox - Version 1.0

If you wish Scan Mailbox to accept or delete incoming mail based on its subject, click on the Subjects
tab, enter a character string in the box marked Accept Mail with Subjects or Kill Mail with Subjects 
and click on Apply. Any number of Subjects can be entered in these lists. To delete a Subject from 
one of the lists, select the desired entry from the list by clicking on it and click on Delete.

Accepting or Killing on Addressee

If you wish Scan Mailbox to accept or delete incoming mail based on its addressee, click on the 
Addressees tab, enter a character string in the box marked Accept Mail To or Kill Mail To and click 
on Apply. Any number of Addressees can be entered in this list. To delete an Addressee from one of 
the lists, select the desired entry from the list by clicking on it and click on Delete.

When you have entered all your desired Mail Kill criteria, click on OK.

Mail Kill criteria may be added to the lists and deleted from the lists at any time by selecting Mail 
Kill from the Configure menu under the File menu.

Note that by using the “/C” command line option, it is possible to configure Scan Mailbox to connect 
to a series of POP3 accounts, kill any mail which matches the user-specified criteria and disconnect, 
all without any user intervention. If you want to connect and kill semi-automatically, but to have the 
opportunity to review mail marked for deletion, use just one ‘/C’ command line argument followed by 
‘/K’ and ‘/S’.
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Kill file format

Kill criteria entered into the Mail Kill configuration window are stored in a file named ‘mailkill.txt’ in
the Scan Mailbox directory. As an alternative to entering criteria directly into the program, this file 
may be created with a text editor or with any word processor which is capable of producing pure text 
(ASCII) files. The format of this file is as follows:

Each line in the file consists of a single Kill criterion with the format:

<kill type><kill string>

where <kill type> is:

; for a Sender Accept criterion
: for a Sender Kill criterion
% for a Subject Accept criterion
! for a Subject Kill criterion
@ for an Addressee Accept criterion
& for an Addressee Kill criterion

A line in the Mail Kill file can be disabled temporarily by prefixing it with an asterisk (*).

The status of the Mail Kill Active and Kill on Size switches is stored in the scanmail.ini file.

15. Use with Other Mail Programs
Scan Mailbox is intended to complement your usual mail program, not to replace it.

A typical use of this program is to scan waiting mail as soon as you connect to your ISP and then to 
switch on your usual mail program to retrieve wanted mail.

It is important to be aware that strange, although predictable, effects will occur if this program is used 
while your usual mail program is accepting incoming mail using SMTP. For this reason, it is 
recommended that you switch off any SMTP Server functions in your usual mail program while using 
Scan Mailbox.

Note that Scan Mailbox can optionally start your usual mail program, or instruct it to retrieve email, 
when disconnecting from the POP3 server: see the Mailer tab in Account Options.
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16. Help
A Windows Help file is provided with the program and may be invoked in several ways:

· Pressing F1 from anywhere in the program, or selecting Contents from the Help menu, 
displays the Help Contents page.

· Selecting Search for Help On from the Help menu displays a Help Topics window.

· Specific help is also available by pressing the Help button in the Global Options, Account 
Options, Account Configuration and Mail Kill dialogues.

17. Planned Enhancements
Future versions of Scan Mailbox may:

· Implement suggested enhancements from the “wish list” - see the Release Notes from the Help
menu for details.

 · Any other features you would like it to have, provided that these are generally useful. But bear 
in mind that Scan Mailbox is not intended to be a replacement for other mail programs, so I 
have no wish to develop it into a fully-featured mailer.

18. Restrictions
The following is a known restriction:

· Scan Mailbox is unable to display messages larger than about 63K characters in size. If an 
attempt is made to do so, the end of the displayed message will be truncated. This restriction 
does not apply when saving messages to a file.
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19. Technical Information
Scan Mailbox conforms to RFC 1939 “Post Office Protocol - version 3” available from 
ftp://ftp.demon.co.uk/pub/doc/rfc/rfc1939.txt and elsewhere.

Scan Mailbox supports two extensions to RFC 1939 implemented by Demon's POP3 server:

· By responding to the server’s “USER” prompt with a Demon hostname, the server provides 
details of all waiting mail for the named host; whereas by responding to the "USER" prompt 
with ‘user@hostname’ or with ‘user+hostname’, the server provides details only of messages 
for the named user.

· Demon’s POP3 server implements a “*ENV” command which provides details of the envelope 
MAIL FROM and RCPT TO values. The format of the server’s response to the *ENV 
command is:

Line 1: “ok”, or “rd” if the message has been read. Remainder undefined
Line 2: Undefined
Line 3: The envelope MAIL FROM value
Line 4: The envelope RCPT TO value

Case is undefined.

A list of Frequently Asked Questions (FAQ) about Demon Internet’s POP3 service is available from:

http://www.demon.net/connect/dial-up/services/pop3.html
ftp://ftp.demon.co.uk/pub/demon/doc/pop3.txt

or send an email to support@demon.net with a single subject line of:

send pop3

Technical details about Demon Internet’s POP3 service are available from:

http://www.demon.net/connect/dial-up/services/sdps-tech.html
ftp://ftp.demon.co.uk/pub/demon/doc/sdps-tech.html

or send an email to support@demon.net with a single subject line of:

send sdps-tech

Scan Mailbox is written in Visual Basic 4 and uses winsock OCX technology licensed from Dolphin 
Systems at http://www.dolphinsys.com
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32 bit version for Windows 95 and NT

The Windows 95 and NT distribution file contains the following compressed files:

Destined for \windows\system:

File Size Version

comctl32.ocx 332,288 1.0.2908
comdlg32.ocx 92,672 1.0.2415
dssock32.ocx 80,896 1.90.100
grid32.ocx 89,600 1.0.2908
mfc40.dll 924,432 4.1.6139
msvcrt40.dll 326,656 4.10.6038
olepro32.dll 74,000 4.1.6038
regsvr32.exe 24,064 4.00
tabctl32.ocx 129,536 1.0.0023

Destined for the Scan Mailbox directory:

manual.doc manual.pdf
scanmail.exe scanmail.hlp
readme.txt scanmail.cnt
changes.txt

The ‘readme.txt’ file contains installation instructions.

32 bit Scan Mailbox also requires the following support library which is available separately from 
http://www.kempston.demon.co.uk/smb/ and should be placed in \windows\system:

vb40032.dll

Scan Mailbox also requires the following file which is part of standard Windows 95:

In \windows\system:

msvcrt20.dll
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16 bit version for Windows 3.x

The Windows 3.x distribution file contains the following compressed files:

Destined for \windows\system:

File Size Version

comdlg16.ocx 81,136 1.0.2908
compobj.dll 109,056 2.03
ctl3dv2.dll 27,632 2.31
dssock.vbx 21,024 1.25.00
grid16.ocx 85,536 1.0.2908
oc25.dll 536,048 2.53
ole2.dll 304,640 2.03
ole2disp.dll 164,960 2.03
ole2nls.dll 152,976 2.03
storage.dll 157,696 2.03
tabctl16.ocx 115,424 1.0.0023
typelib.dll 177,824 2.03
vaen21.olb 35,200 2.0.5422

Destined for the Scan Mailbox directory:

manual.doc manual.pdf
readme.txt scanmail.exe
scanmail.hlp scanmail.cnt
changes.txt

The ‘readme.txt’ file contains installation instructions.

16 bit Scan Mailbox also requires the following support library, which is available separately from 
http://www.kempston.demon.co.uk/smb/ and should be placed in \windows\system:

vb40016.dll

All Versions

When Scan Mailbox is first run, it creates the following files in the Scan Mailbox directory:

scanmail.ini Holds the Scan Mailbox configuration information. This file should not be 
edited directly.

log.txt A record of the POP3 dialogue and user actions.

logkill.txt A record of any mail messages deleted on the server because they match 
user-specified Kill criteria.

Both log files are overwritten by default each time Scan Mailbox is started. An option on the Log 
Files tab in Global Options allows them to be appended each time Scan Mailbox is run. 
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20. Support and Mailing Lists
Any comments you wish to make about Scan Mailbox will be gratefully received. Reports of bugs and 
suggestions for improvement will be especially welcomed. Please address comments and bug reports 
by email to one of:

smb@kempston.demon.co.uk

The smb-dev mailing list (described below)

When reporting a bug, it would be helpful to describe exactly what you were doing with the program 
at the time, exactly what program behaviour you feel is wrong, and to forward a copy of the log.txt file
from the Scan Mailbox directory. Please note that this file contains a copy of any mail messages 
displayed by Scan Mailbox and you may wish to edit it to remove any confidential material before 
sending the file to me. The log.txt file does not contain your password.

In some circumstances, it may be helpful to email a copy of your Scan Mailbox configuration file 
scanmail.ini to the author of this program. Please note that this file does contain your POP3 passwords 
in encrypted form and it is best to make a copy of this file, edit the copy to remove lines starting 
‘EPASS=’ and send the copy.

Technical support is freely available by email from smb@kempston.demon.co.uk and from the smb-
dev mailing list. Although Scan Mailbox is not supported by Demon or Netcom, you are welcome to 
post queries to the demon.ip.support.newuser, demon.ip.support.win95 and netcom.uk.support.win95 
newsgroups where they will be answered by me or by other users of the program. Please do not call 
your ISP for support: Scan Mailbox is not supported by the ISPs on whose servers the program is held.

There are two mailing lists devoted to Scan Mailbox and you are welcome to join one or both of them:

The Scan Mailbox Announce List

This is a low volume moderated mailing list which will be used only to inform subscribers about the 
release of new versions of Scan Mailbox. It is unlikely that there will be more than one message every 
few months sent to this list.

To join this list, send an email to:

listserver@kempston.demon.co.uk

Leave the subject blank, and put the following text in the body of the email:

SUBSCRIBE smb-announce

The list will respond by sending a control message to the prospective subscriber. You must reply to the
control message using the normal reply function in your email program. Do not change any of the text 
in the subject line of the control message or your subscription will be refused. 

If your control message is accepted, you will receive a welcome message by return which explains 
how the list operates. This process may seem longwinded, but it ensures that you are not subscribed to 
the list by a third party against your wishes, and that you have given a valid return address to which 
messages from the list can be delivered reliably.
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Information about the mailing list can be obtained by sending an email to 
listserver@kempston.demon.co.uk with a blank subject and the following text in the body of the 
email:

HELP smb-announce

The Scan Mailbox Development and Support List

This mailing list is primarily a discussion forum for the development of the Scan Mailbox program. It 
is open to all who have an interest in the program, whether they wish to post messages or simply 
monitor the discussions. The list is unmoderated and contributions are welcome from anyone who 
wishes to suggest and discuss proposed changes and enhancements to the program, or seek or provide 
support on its use. It is likely that intermediate releases of the program will be made available to 
members of this list.

To join this list, send an email to:

listserver@kempston.demon.co.uk

Leave the subject blank, and put the following text in the body of the email:

SUBSCRIBE smb-dev

You will need to respond to the control message sent in reply by the list as described for the 
“Announce” list above.

Information about the mailing list can be obtained by sending an email to 
listserver@kempston.demon.co.uk with a blank subject and the following text in the body of the 
email:

HELP smb-dev

The email addresses of subscribers to both these mailing lists will be kept confidential. They will not 
be disclosed to anyone else and will not be used for any purpose other than the stated purpose of the 
mailing lists.
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21. Copyright and Disclaimer
While every care has been taken to avoid data loss in the development of this program, Scan Mailbox 
is supplied as is and no liability for consequential or other loss is expressed or implied.

Scan Mailbox is provided free for non-commercial use and can be used indefinitely without charge or 
obligation. I would appreciate a short email if you use the program. Please address enquiries about use
for commercial purposes to smb@kempston.demon.co.uk

Both the program and this User Guide are Copyright © Mike Mann 1998.

The program is available from:

http://www.kempston.demon.co.uk/smb/
http://www.netcomuk.co.uk/~kempston/smb/

from mirrors of these Web pages and from certain ftp sites.

This program and associated documentation must not be distributed on CD, by means of any Web or 
ftp site, on any BBS system, or by any other means without the express permission of the author. 
Permission will normally be granted. Enquiries should be addressed to smb@kempston.demon.co.uk

The name ScanMail was registered as a trademark in the US by Trend Micro Inc. 
(http://www.trendmicro.com and http://www.antivirus.com) on 21st October 1997. The name POP3 
ScanMail had been used by this program since December 1996, but was changed to POP3 
Scan Mailbox in January 1998 to avoid conflicting with the use of the name by Trend Micro.

Microsoft is a registered trademark and Windows is a trademark of Microsoft Corporation 
(http://www.microsoft.com)

Turnpike is a trademark of Turnpike Limited (http://www.turnpike.com)

Eudora is a trademark of the University of Illinois Board of Trustees, licensed to QUALCOMM Inc 
(http://www.qualcomm.com)

Pegasus is a trademark of David Harris, all rights reserved (mailto:tech-support@pmail.gen.nz) 

Agent is a trademark of Forté Advanced Management Software Inc. (http://www.forteinc.com)

Unix is a trademark of UNIX System Laboratories.
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